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Starting DVR Examiner for the First Time 
 

When you start DVR Examiner for the first time, DVR Examiner will look for an active license.  If no active license is 
found, a ‘No License Found’ screen will be displayed.  From this screen you can: 
 

• Enter a license key and activate it 
• Check for a connected dongle 
• Sign up for a Free Trial - If your computer is web 

connected this option will connect you to the 
DME Forensics website where you can sign up 
for a Trial Key to activate a trial version of DVR 
Examiner. 

 

 
 

Licensing your Software  
 

Dongle License 
If you are using a dongle for licensing, plug the dongle in prior to starting DVR Examiner.  When you start DVR 
Examiner, the Dongle Detected screen will appear. This screen will display the Dongle ID, the Subscription start and end 
dates, and to whom the dongle is registered.  Click continue to move to the landing screen or DVR Examiner will 
continue after 10 seconds.  You can also plug your dongle in after the ‘No License Screen’ has appeared. Simply plug in 
the dongle and press ‘Check for Dongle’. 
 

 

Note: If the dongle is plugged in and you still get the ‘No 
License Found’ Screen, please close DVR Examiner, 
reseat the USB dongle and then restart DVR Examiner.  
You can also try different USB ports on your computer. 
 

                                                  

 

Trial, Case or Host License 
When you first start DVR Examiner, you will see the ‘No License Found’ screen.  If you have purchased a trial, case, or 
host license key, enter the key in the provided text box and click ‘Activate’.  A new screen will appear indicating your 
license type, the license start and end dates, and the number of days until expiration.  Click continue to move to the 
landing screen or DVR Examiner will continue after 10 seconds.  You will only have to enter your license key once.  DVR 
Examiner will remember your key and you will not be required to re-enter it each time you start DVR Examiner.  
 

                      



 
Unlicensed Dongle Detected 
The Unlicensed Dongle Detected window will display if DVR Examiner recognizes a dongle connected to the 
workstation but does not recognize it as a licensed dongle. If you recently purchased DVR Examiner after downloading 
a trial version, you may need to update the software to reflect your new subscription.  
 
If you are on a web connected computer, you can click the "Portal" button to connect to our support portal and 
download the latest version. If you are not on a web connected computer, you can visit the portal on a separate 
computer and download the zip file for the latest version then transfer it to the desired workstation. 
 

 
 

Expired Subscription 
The Expired Subscription screen will notify you when the subscription for the connected dongle has expired. This 
screen will display the Dongle ID, the Subscription Start and End dates, and to whom the dongle is registered.  Saved 
cases may still be accessible even with an expired license. Cases saved prior to version 2.2 will need to be opened in 
the version in which they were created.   

 

 
 
 
If your subscriptions started before DVR Examiner 2.0 
was released, you will have access DVR Examiner 1.x 
indefinitely and will only need to update your license 
database every 90 days to continue using it. 

 
 

 
Expired License Database 
In addition to USB Dongles, DVR Examiner uses an encrypted license database to authorize and de-authorize your 
USB Dongles. This allows us to instantly license new dongles, as well as turn off dongles that are lost or stolen. If your 
dongle is ever lost or stolen, you can purchase a replacement dongle instead of having to purchase a whole new 
license to DVR Examiner.  



 
 
 
The Expired License Database screen may only appear if 
DVR Examiner is installed on a dark computer.  
Computers connected to the Internet will automatically 
update the license database.  Information available on the 
Expired License Database screen include License 
Database Creation Date and License Database Expire 
Date.   

 
 

Updating an Expired License Database 
A web-connected computer will automatically check for an updated License Database file when you Start DVR Examiner.     

If you are on a dark computer and the license database is expired, you will need to download the license database file 
from a web-connected computer and move the file to the dark computer.   To obtain a new license database file, please 
visit our Portal at dmeforensics.com/portal to download the file.   An active Portal account is required.  Once you have 
downloaded and moved the license database file to the dark computer, you can select ‘Import License Database’ and 
browse to the location of the file.  DVR Examiner will automatically replace the old license file and take you to the 
Source Selection (Landing) Screen.   

Signing Up for a Free Trial 
You may sign up for a free trail by clicking the ‘Free Trail’ button on the ‘No License Found’ screen or by visiting our 
website at dmeforensics.com/dvrexaminer/freetrail. 
 
 

Landing Screen 
 
The Landing Screen (Welcome tab) provides four options to get started with DVR Examiner. This screen also provides 
helpful tips for using DVR Examiner as well as links to our social media accounts 
 

 

 
 

• Detect and Scan 
Hard Drive 
 

• Detect and Scan 
Image File 
 

• Load Saved Case 
 

• Create Forensic 
Image 

 
 
Detect and Scan Hard Drive 
Select this option if you want to recover clips from a physical DVR hard drive. Ensure the physical disk to be analyzed is 
connected to the computer operating DVR Examiner. It is strongly recommended all evidentiary physical media be write 
protected in accordance with agency policies and discipline best practices. 

http://portal.dmeforensics.com/technology/dvrexaminer/freetrial


 
 
The Detect and Scan Hard Drive section displays a grid of all available physical media to be scanned. Select ‘Refresh’ to 
generate a new grid of available physical media sources.  
 

 
The hard drive selection grid will contain basic information about all drives detected including: 

• Disk - Disk Number 
• S/N - Serial Number of the hard drive detected 
• Model - Model of the hard drive detected 
• Size - Size (in GB) of the hard drive detected 

 

Once the desired physical media source is identified, simply highlight the row representing the desired drive and select 
‘Go’.   

You can also double-click the row of the desired drive.  The ‘Go’ button will not be enabled unless a drive has been 
selected. 

Note: If the desired physical disk is not present, check all physical connections to the media and ensure the write 
blocker is powered on.  Also verify you are scanning a physical hard drive from a DVR and not a forensic image 
located on a hard drive.  If you are scanning a forensic image, use the ‘Detect and Scan Image File’ option. 
 

Detect and Scan Image File 
Select this option if you want to recover clips from a forensic image of a DVR hard drive. DVR Examiner supports both 
.E01 and .dd raw image files. 

 
Note: Using an image file of the physical disk will help preserve the original DVR physical evidence disk.  It is 
recommended that the forensic image be stored on the computer running DVR Examiner. 

The Detect and Scan an Image File screen will provide you with two options for accessing an image file to scan.  
 

• Browse Button - The ‘Browse’ button allows you to navigate to the desired image file and highlight it. After 
highlighting the image file, select open.  
 

• Grid List – The grid list allows you to select recently scanned image files.  The grid list contains the following 
information:  
 

o Path – The name of the image file.  Hovering over the name will display the location (path) of the image 
file. 
 

o Filesystem – Filesystem name of the scanned image. 
 



 
o First Accessed – Date and time the image was first accessed. 

 
o Is Available – A check mark here indicates that the file is in the same location when previously 

scanned and can be accessed via DVR Examiner.  
 
Click once on the desired file to highlight it.  Press ‘Go’ to begin the scan.  You can also double-click the row of the 
desired drive.  The ‘Go’ button will not be enabled unless a drive has been selected.   

 
Note: Segmented image files can be used only if the first file has the extension of .001 and there must be fewer than 
1000 segments in total (the last extension would have an extension of .999). 
 
Note: A forensic image may also be mounted.  It is recommended that the image reside on the same computer that is 
running DVR Examiner.  When using a mounted image, you will need to select the ‘Detect and Scan Hard Drive’ option.  
 

Load a Saved Case 
Select this option if you have previously worked on and saved a case from the clip list screen.  Use this to load cases 
regardless of what was originally scanned.  If you saved a case while working with a physical disk, that disk will need to 
be connected and accessible for the saved case to load.  If you saved a case while using a forensic image, that image 
file must be accessible by DVR Examiner.  

 
Note: Cases saved prior to version 2.2 will need to be opened in the version in which they were created.  If your 
subscription started prior to DVR Examiner 2.0 being released, you will have access DVR Examiner 1.x indefinitely and 
will only need to update your license database every 90 days to continue using it. 
 
Create a Forensic Image 
DVR Examiner allows the user to create raw disk images (.dd) without the use of a third-party program. Creating a raw 
disk image helps protect the original DVR physical media evidence and processing times will typically be faster. It is 
highly recommended the DVR physical media is properly write protected and handled in accordance with Digital and 
Multimedia Evidence best practices and any internal policies.  
 

 
 
Once a physical media has been selected, destinations for the image file must be assigned. DVR Examiner allows for 
the creation of multiple copies of the image to be created for a single physical media source. For example, this allows 
for the creation of an archive and working image from the physical media. The generated images can be stored in 
different locations if desired. Including multiple destinations will increase the time it takes to complete the image, 
particularly when choosing the "Hash Destination(s)" option.  



 
 

 
 

Image Creation Options: 
 

• Hash Source - DVR Examiner will calculate a MD5 and/or a SHA hash value for the source media selected. 

• Hash Destination - DVR Examiner will calculate a MD5 and/or a SHA hash value for each image created (multiple 
images may be created in different locations). 

• Stop on Bad Sectors - If a bad sector is encountered during image creation, DVR Examiner will stop the imaging 
process and notify the user. 

Detecting a Filesystem 
 
Although DVR Examiner currently supports over 200 filesystems, many others exist that may not yet be supported by 
DVR Examiner.  The following Detection Screens may appear: 
 

• Support System Identified – The filesystem is identified and supported. 
 

• System Identified - Support Pending – The filesystem is identified, but not yet supported. 
 

• Unrecognized Filesystem – The filesystem has not been identified. 
 

• NTFS Partition Detected – DVR Examiner detects an NTFS Partition. 
 

Supported System Identified 
The Support System Identified screen appears when DVR Examiner has successfully identified the filesystem of a hard 
drive. This screen provides a summary of DVR Examiner Features as well as filesystem information including 
Filesystem Name, Filesystem Version, and Video Format.  All features supported by the filesystem will be orange while 
unsupported features will be gray.   
 



 

 
Features 
DVR Examiner support a variety of features that aid in the recovery of video from the hard drive.  Not all features are 
supported with all filesystems.  Below is a brief description of each feature.   

• Inaccessible - The ability of DVR Examiner to recover data no longer accessible via the DVR itself. Two types of 
inaccessible scans are possible, “Inaccessible" or "Frame Level Inaccessible".  For more information on 
Inaccessible scans, visit https://dmeforensics.com/inaccessible-date-recovery-with-dvr-examiner/ 

 
• Frame Level Timestamps - DVR Examiner supports the recovery of Frame Level Timestamps. 

 
• Uses Time Zones - DVR Examiner has identified that the DVR uses Coordinated Universal Time (UTC) as the 

basis for the clip date/time. If this feature is support, filtering options will allow you to add time zone 
specifications. 

 
• Recovers Recording Types - Identifies channel Recording Types such as Motion, Continuous, Motion and 

Continuous, etc. 
 

• Channel Name Recovery - Denotes the ability of DVR Examiner to recover names assigned to channels through 
the DVR user interface. This can be helpful when trying to identify a specific channel’s possible field of vision. 

 
• Thumbnails - DVR Examiner will be able to generate thumbnails for any recovered clips. Thumbnails are 

generated when the clip is Processed for Motion, Video Properties are retrieved, or the clip is Previewed. 
 

• Video Dimensions - A potential part of recovering video properties, this option indicates that DVR Examiner will 
be able to recover video dimension information. 

 
• Preview - DVR Examiner supports the ability to preview any recovered data. 

 
• Native Player Available - This indicates that DVR Examiner can export the DVR's native video file formats from 

the hard drive and that the native file player is available for download. 
 

• Audio - DVR Examiner supports Audio recovery for the scanned filesystem. 
 

https://dmeforensics.com/inaccessible-date-recovery-with-dvr-examiner/


 
System Identified - Support Pending 
The Support Pending screen will display if DVR Examiner recognizes the filesystem but support has not yet been 
added. We prioritize support for pending systems based on user feedback and number of requests, so please let us 
know when you encounter one of these filesystems.   

 

 
 
 
 

Please email DME Forensics at 
support@dmeforensics.com or call  

1-800-413-0363 to let us know what filesystem 
you have encountered.  We add support based 

on the number of requests for a given filesystem. 

 
Unrecognized Filesystem Detected 
If DVR Examiner cannot identify the filesystem, The Unrecognized System Detect screen will be displayed. On this 
screen, you will have the option to create a DVR Profiler which will help us implement support for the filesystem.  DVR 
Profiler will ONLY access the information contained on the DVR physical media or image file. The only data collected 
will be Physical drive architecture (sector allocation, filesystem(s), partition type(s)...etc.), File structure information, 5MB 
of data or less from the DVR in most cases.  

 
 
 
At no point will DVR Profiler access ANY data or 
system information from the workstation running 
DVR Examiner. DVR Profiler will ONLY access a 
small amount of data contained on the DVR 
physical media or DVR image file. 
  
 

 
Please complete as much information about the unsupported DVR as possible. Include contact information so we can 
provide you with any updates regarding the specific DVR system. Photographs of the DVR are very important. Good 
quality photographs of the following areas provide the most valuable information: 

• Front of the DVR, including any make/model information. 
 

• Back of the DVR including all input/output ports. 
 

• Serial number and manufacturer plate (usually located on the bottom or back of the DVR). 
 

• The main system circuit board, with attention paid to any distinct numbers or identifiers. Many manufactures 
use the same system board and may be a critical piece of information for the "black-box-no-name" DVR 
models. 

Select the "Browse" button to select photographs to include with the DVR Profiler report. These images will be included 
in the report sent to DME Forensics. Be aware that excessively large image files may affect the transmission process. 
 

mailto:support@dmeforensics.com


 
NTFS Partition Detected 
The NTFS Partition Detected screen will appear if DVR Examiner detects an NTFS partition in the source media.  
 

 

 
 
 
 
Note: If you are attempting to process a forensic 
image contained on a physical disk, please select 
‘Detect and Scan Image File’ from the Landing 
Screen. 
 

 
While it is possible that a DVR can use NTFS, in a typical unbranded black box style embedded system, it would be very 
unusual.  Typical causes for this message are either a) scanning the physical drive containing the image of the DVR 
hard drive, or b) the DVR Hard drive was at some point inserted into a computer and formatted as NTFS.  
 
DVR Examiner does not currently support recovery from NTFS drives, as those are typically found in enterprise grade 
systems and are easier to recover using standard computer forensic tools. 
 

Scan Options 
 
Scan Options were designed to accommodate differing business processes, so no matter what your work flow looks   
like, DVR Examiner can be seamlessly integrated into your data recovery routine. Specifying additional scan options 
can result in longer scan times but will be helpful if you are starting a scan before leaving for the day with the intent of 
having supported features included during the scan, instead of selecting these features on a per clip basis after scan. 
Scan Options will be determined by the support features available for the filesystem being scanned. The 'Configure 
Date/Time Offset', 'Begin Export on Scan Completion', and 'Filter Clip List Results' toggle buttons will allow you to apply 
some basic export and filtering options before scanning. If you do not wish to apply any pre-scan criteria, simply click 
continue.  

Filesystem Dependent Scan Options 
Certain scans options will only be visible if the filesystem you are working with supports them.  Filesystem dependent 
scan options include ‘Scan for Inaccessible Data’ and ‘Get Video Properties’. 
 

Scan for Inaccessible Data - This button will be visible if, for 
a filesystem, DVR Examiner allows for the recovery of data 
which may have been deleted, formatted, become corrupted 
or is not accessible to the DVR. It is recommended the 
normal recovery mode be attempted first, as this process is 
generally much faster than scanning for data inaccessible 
to the DVR. 

Get Video Properties - Processes all clips for additional 
properties (thumbnails, video dimensions, frame rate, etc.) 
during scan.  Selecting this option will result in longer scan 
times. 



 
 
Configure Date/Time Offset 
When you select ‘Configure Date/Time Offset’, a white check mark will be added to the icon and the configuration 
screen will appear.  Here you will be able to select a time zone and adjust the DVR and Actual Date and Time.  
 
Time Zone - Coordinated Universal Time (UTC) is one of the 
primary time standards by which the world regulates clocks 
and time. Some DVRs base time on the offset of the local 
time versus a UTC time. If DVR Examiner identifies UTC 
time as the basis for clip date/time, the Time Zone 
Configuration filter may be used to adjust the reported 
date/time to the current date/time. If the DVR date/time is 
not based on UTC, the Time Zone Configuration dialog box 
will not be visible.  If a time zone is enabled, all future 
filtering options will work from the adjusted timestamps. 

Configure Date/Time Offset- This option allows you to adjust for any difference between the actual date/time and the 
time set on the DVR before scanning. Enter the date/time on the DVR and the Actual date/time and DVR Examiner will 
show the adjusted timestamp of any recovered clips alongside the recovered timestamp. The drop-down button can be 
selected for a calendar view. Highlighting specific date/time denominations will allow you to increase or decrease the 
selected denomination using your keyboard up and down arrows. If an offset is enabled, all future filtering options will 
work from the adjusted timestamps. 

Begin Export on Scan Completion  
When you select ‘Begin Export on Scan Completion’, a white check mark will be added to the icon and the configuration 
screen will appear. By enabling this feature, DVR Examiner will automatically begin exporting clips (after scan 
complete) based on the filter parameters.   

 
Destination - Select a folder to place the exported data. 
Select "Browse" to change the export location/folder. You 
will not be able to start the export until a destination is 
selected. 

Formats - Lists all available export format based on the DVR 
metadata. You will not be able to start the export until at 
least one export format is selected. 

Hash Algorithm – Selecting a hash algorithm on exported 
clips assigns a hash value to each exported clip.  Select 

from None, MD5, SHA1, or MD5 & SHA1.  Selecting any of the hash algorithms will lengthen the total export time.  

Folder Organization- The Folder Organization drop down determines how the exported clips will be organized within 
the destination folder.  

• Date/Files – puts all exported clips into separate folders depending on the date of the clip with a folder per day. 
• Channel/Files – puts all exported clips into separate folders depending on the channel of the clip with a folder 

per channel. 
• Date/Channel/Files – puts all exported clips into separate folders first separated by date then by channel with 

a folder per date then a folder per channel within each date folder. 
• Channel/Date/Files – puts all exported clips into separate folders first separated by channel then by date with 

a folder per channel then a folder per date within each channel folder. 

Use Adjusted Date/Time in File Name - If there is an adjusted date/time associated with any or all of the clips, this 
checkbox will be enabled. If selected, this option will use the adjusted date/time in the file name as opposed to the 
date/time recovered from the hard drive. If export folders are organized according to dates, the adjusted date will be 
used for folder organization as well. 



 
Report Format - The Report Format drop down will allow you to specify the output format of the export report. The 
export report is defaulted to HTML.  Support for PDF and Excel formats coming soon.  

Export Notes - Export Notes will automatically be included in the export report. 
 

Filter Options 
When you select ‘Filter Options’, a white check mark will be added to the icon and the configuration screen will appear. 
Filter options set on this screen will be applied during the scan, resulting in only clips matching the filter options to be 
displayed.  To make changes to the filter options, you will need to select ‘New Source’ (View Tab  New Source) and 
re-scan the drive.     

 

Filter Type - If you know the period of time you are searching for before scanning the hard drive, you can specify the 
exact time period of video to display in the clip list. You have the option to scan for all clips within a certain number of 
hours going back from the most recent recorded date/time or you can select a specific window of time in which to 
recover clips. If a Date/Time Offset has been specified, the search filter will apply to the adjusted date/time. 

Apply Filter To - After selecting the time range for the clips you wish to recover you can specify what scan options the 
Filter Type applies to. 

• Clip List - Only clips matching the filter will be added to the clip list. Clips will have the same clip ID as when 
performing a normal scan. If the clip list is filtered before initiating a scan, the only way to access filtered clips 
will be to select "New Source" in the Ribbon options and re-scan the drive as if scanning new source media. 

• Exported Clips - Only clips matching the filter will be exported. If the option to ‘Begin Export on Scan 
Completion’ has not been selected, this option will not be enabled. 

• Video Properties - Only clips matching the filter will be processed for additional video properties such as 
thumbnails, video dimensions, etc. If the option for ‘Get Video Properties’ has not been selected, this option will 
not be enabled. 

Case Information 
The Case Information screen allows you to enter information specific to the DVR being scanned.  These fields can be 
changed to fit your specific needs.  You can also set default values for any of the fields.  This is accomplished by 
accessing the OPTIONS tab once a scan is complete.  See OPTIONS TAB section for more details. 

 



 

Clip List 
 

When the clip list tab is active, there are four main sections of the screen: Ribbon Buttons, Filter Options, Clip List Grid, 
and the Side Bar.   

 

Ribbon Buttons – View Tab 
Accessing the View Tab while on a clip list displays actions that will help you to sort, preview and export clips, as well 
as access a new source, save a case, or access the options screen.  

 
 

 

New Source - When selected, this function will take the user back to the Landing screen where a new 
physical media or image file may be selected for analysis. Caution: If the current case is not saved 
before selection of this option, the current case will be lost and must be re-scanned.  
 

 

Save - Allows for the current case to be saved. The user will navigate to a storage location and 
assign a name for the case. 

 

All – Displays all recovered clips in the clip grid regardless of current filters applied. Clicking ‘All’ will 
Disable the filters, but not clear them.  

 

Matching Filters - Displays only clips that match the currently applied filters. 

 

Marked for Export - Displays only clips selected for export. 



 

 

Select All - Highlights all clips currently in the clip grid. Multi-clip options can then be applied to all 
selected clips, such as export and per clip offset configuration. 

 

Select None- De-selects any clips currently selected. 

 

Mark Selected For Export - Automatically checks the export checkbox of any clip that is currently 
selected in the clip grid. 

 

Unmark Selected For Export - Automatically un-checks the export checkbox of any clip that is 
currently selected in the clip list. 

 

Preview Selected Clips - Opens a preview tab for each clip selected. 

 

Update Motion Config - Opens Motion Configuration Properties window. Adjust the motion 
sensitivity, minimum still time, and object size on a per channel basis. 

 

Export All Clips - Exports all clips initially returned in the clip list regardless of filters. 

 

Export Marked Clips- All clips in the clip grid with a box in the Export column that is checked will be 
exported. 

 

Export Selected Clips - All clips that are currently selected in the clip grid will be exported. 

 

Options – Opens a new tab.  Available options include changing Date/Time format, Case 
Information Options, and additional Application Options.  See Options section for more details. 

 

Welcome - Opens or activations the Welcome tab.  Available options include selecting a new source, 
opening the Options tab, and exiting the application. 



 

 

Exit Application – Closes DVR Examiner. Any unsaved cases or filtering specifications will be lost, 
and all active jobs will be canceled. 

 

Exit All Additional Tabs – Closes all tabs except the Clip List tab. Any jobs (export, preview, etc.) 
currently associated with these open tabs will be canceled. 

 
Ribbon Buttons - Reporting Tab 
The Reporting tab contains links that generate specific reports based on the clips in the clip list.  You can also update 
case information from this tab.  

 

 

 

Clip List Report (PDF) – Generates a clip list report in PDF format and saves to your desktop.  
Information within the Clip list report include case details, filesystem details, Source details, and clip 
information including clip ID, channel, Start and End time, Duration, Size, clip status, and preview 
thumbnail.  All clips returned in the scan are included in the report. 

 

Clip List Report (Excel) – Generates a clip list report in M.S. Excel format and saves to your desktop.  
Information within the Clip list report include case details, filesystem details, Source details, and clip 
information including clip ID, channel, Start and End time, Duration, Size, clip status, and preview 
thumbnail.  All clips returned in the scan are included in the report. 

 

Currently Filtered Clips (PDF) – Generates a clip list report in PDF format and saves to your desktop.  
Information within the Clip list report include case details, filesystem details, Source details, and clip 
information including clip ID, channel, Start and End time, Duration, Size, clip status, and preview 
thumbnail.  Only clips currently displayed will be included in the report.  

 

Selected (PDF) – Generates a clip list report in PDF format and saves to your desktop.   
Information within the Audit report include case details, filesystem details, source details, Global 
Actions, and actions performed on specific clips.  Only selected clips will be included in the report. 

 

View Selected Clips Report (NEW!) – Opens an internal viewer that allows you to view the report right 
in DVR Examiner.  You can search through the document, print the document, or save the document in 
a number of formats, including PDF, Word, and Excel.  

 

Audit Log Report – Generates an audit report in PDF format and saves to your desktop.  Information 
within the Audit report include case details, filesystem details, source details, Global Actions, and 
actions performed on specific clips.  All clips returned in the scan are included in the report. 

 

Update Case Information - Opens the Case Information screen and allows you to update fields within 
this window.  Note: To change default case information or to add/remove fields, refer to the OPTIONS 
tab section of this document.  

 



 
Ribbon Buttons - Help Tab 
The help tab contains links and information that help in identifying the filesystem as well as features to help us gather 
important information regarding the filesystem or DVR. 

 

 

 

User Manual - The User Manual ribbon button will take you to the online user guide if web connected 
and open a pdf copy of the user manual if you are not. 

 

Support Portal – If you are web connected, the Support Portal option will automatically take you to the 
DME Forensics Customer Portal log in page. The support portal will provide you with access to 
subscription information, proprietary player downloads, and many other support options related to 
DVR Examiner. Visit the support portal at dmeforensics.com/portal. 

 

Download DVR Player – This option, when available, downloads the native file player to your desktop.  
The native file player is used to view exported clips in the DVRs native file format. 

 

Open Logs Directory- This button will open the logs folder in the DVR Examiner installation folder 
where Session, Error, and Debug logs are stored. 

 

Show Job Manager – Opens the Options tab.  The job manager section of the options tab includes 
information about active, pending, and completed jobs. Individual jobs can be paused, re-started, or 
canceled from this tab. 

 

See Detection Results – Clicking on this button will open the Supported System Identified screen.  
Here you will find information pertaining to the DVR scanned, including Filesystem name, Filesystem 
version, Video format and all supported features.  Note: clicking Back or Continue will close the 
window.  
 
 

 

Copy Host Signature / Copy Data Signature – When you put your mouse over the Copy Host 
Signature text, a text box will appear with the Host Signature of your computer.  Clicking on the text 
will copy the signature to your clipboard.  When you put your mouse over the Copy Data Signature 
text, a text box will appear with the Data Signature of the hard drive you scanned.  Clicking on the text 
will copy the signature to your clipboard.   

 

Capture Data For Support – This option will only be necessary when a request is made for additional 
data from the DME Forensics Technical Support team. This option will recover additional data from a 
specified section of the hard drive to be analyzed by technical support to track down any unexpected 
errors generated when working with a recognized filesystem. 

 

Send a Profiler - This option will launch a DVR Profiler pop-up screen requesting information about 
the drive and the DVR it was recovered from. The Profiler Request can be automatically sent to DME 
Forensics if web connected or saved to your desktop and then transferred to a separate computer if 
not web connected. 



 
Filter Options 
Filter options set on this screen are applied to all the clips in the clip list.   

 

 
Time Zone - Coordinated Universal Time (UTC) is one of the primary time standards by which the world regulates clocks 
and time. Some DVRs base time on the offset of the local time versus a UTC time. If the DVR Examiner identifies UTC 
time as the basis for clip date/time, the Time Zone Configuration filter may be used to adjust the reported date/time to 
the current date/time. If date/time is not based on UTC, the Time Zone Configuration dialog box will not be visible.  If a 
time zone is enabled, all future filtering options will work from the adjusted timestamps. 
 
Date/Time Configuration- Allows you to adjust for any difference between the actual time and the time set on the DVR 
for all clips in the clips list. The drop-down button can be selected for a calendar view. Highlighting specific date/time 
denominations will allow you to increase or decrease the selected denomination using your keyboard up and down 
arrows. Click the "Enable Offset" button to enable the specified offset. The text will change to "Disable Offset" to allow 
you to disable the offset. This option acts independently of the filtering options and will not be changed when selecting 
"Apply" and "Clear".  If an offset is enabled, all future filtering options will work from the adjusted timestamps.  Note: to 
change the date/time of individual clips, see Date/Time Offset in the Side Bar Section.    
 
Date/Time Filtering - The first and last detected date/time from the scan of the DVR data is automatically populated in 
these fields. The user can manually enter or use the pull-down menus to enter the start and end date/time of interest. 
When applied (and Enable Time of Day Search is Disabled), DVR Examiner will return all clips that fall in between the 
Start Date/Time and the End Date/Time.     
 
Enable Time of Day Search - The Time of Day Search Filter option allows you to select a specific range of time within a 
day and then filter for any clips that fall within that range. For example, say you want to filter only clips that were 
recorded during normal business hours between January 1, 2019 and January 10, 2019. In this example, we would enable 
the "Time of Day" Filter and then select 2019-01-01 09:00:00 as the start date/time and 2019-01-10 17:00:00 as the 
end date/time. When the filter is applied, DVR Examiner will return only clips that were recorded between 9am and 
5pm, January 1, 2019 through January 10,2020. 
 
Include Unknown Date/Time - Depending on the filesystem, when you scan for Inaccessible, DVR Examiner may return 
clips that have no date or time information. This happens when DVR Examiner cannot find any metadata information 
pertaining to the clip. In these cases, DVR Examiner will fill in the date and time with default settings of 0001-01-01 
00:00:00. 
 

 
 
When you select to "Include Unknown Date/Times", DVR Examiner will always display those clips in the filtered clip list 
grid. If you do not wish to have those clips included in any filter results, uncheck the option. 
 

 



 
 
Size Slider - Filter clips based on size in MB. The left slider can be used to designate a minimum size and the right slider 
can be used to designate a maximum size. 
 
Duration Slider- Filter clips based on duration. The left slider can be used to designate a minimum duration and the 
right slider can be used to designate a maximum duration.  
 
Status - The Status dropdown will display a list of all the types of clip statuses returned in the current scan. The clip 
Status refers to accessibility of the specified clip to the DVR. For Example, if you performed an Inaccessible scan and 
DVR Examiner returned both Accessible and Inaccessible clips, and the Status filtering option will display Accessible 
and Inaccessible allowing you to filter by clips recoverable by the DVR interface and clips no longer accessible via the 
DVR itself. 
 
Channel - The Channel dropdown will display all channels in which at least one clip was recovered from the DVR.  If no 
clips were returned for a specific channel, that channel number will not be displayed. 
 
Has Tags – A 3-stage check box.  Defaulted to “filled”, clips with or without tags will be displayed. "Unchecked" will 
return clips that do not have tags. "Checked" will return clips that do have tags. 
 
Has Notes - A 3-stage check box.  Defaulted to “filled”, clips with or without notes will be displayed. "Unchecked" will 
return clips that do not have notes. "Checked" will return clips that do have notes. 
 
Apply/Clear- The Apply button will apply all selected filters to the clip list grid. Selecting the Clear button will return all 
filters to default and result on all available clips being displayed in the clip list grid. 
 

Clip List Grid 
Clip List grid columns will be visible depending on the available data of the filesystem scanned and filtering options 
applied. Columns can be sorted by clicking on the header of the desired column. The first click will present an arrow 
that can be clicked again to toggle between filtering first-to-last and last-to-first. 
 

 

ID – DVR Examiner assigns a unique ID for each clip detected. This is a sequential number and is added to the clips as 
they are detected. For example, if 1000 clips were detected and recovered, the ID would be listed as 1-1000.  Note: 
Setting pre-scan filters may result in non-sequential Clip IDs.   

Channel – Based off the DVR metadata, lists the assigned channel associated with the given clip. Typically, the channel 
number is the same as the camera number, but this is not always the case. 

Channel Name – Denotes the ability of DVR Examiner to recover names assigned to channels through the DVR user 
interface. This can be helpful when trying to identify a specific channel’s possible field of vision. 

Adjusted Start – Shows the Adjusted Start date/time. This column is visible if an offset or Time Zone configuration is 
enabled for one or more clips. The original DVR start and stop times are still listed so the user can compare the two. 

Adjusted End – Shows the Adjusted End date/time. This column is visible if an offset or Time Zone configuration is 
enabled for one or more clips. The original DVR start and stop times are still listed so the user can compare the two. 

Start – Lists the start date/time of the clip based on the DVR metadata. 

End – Lists the end date/time of the clip based on the DVR metadata. 



 
Size – For video-based DVR systems, this represents the size (in megabytes) of each recovered clip. 

Duration – Displays the length of the recovered clip in minutes. 

Recording Type – Identifies channel Recording Types such as Motion, Continuous, Motion and Continuous, etc. 

Clip Status – This column indicates the state of the clip in relation to how the DVR would access the video data 
recovered. Refers to the clip as Available, Accessible to DVR, Inaccessible to DVR and Clip Fragment. 

Has Notes – Denotes whether you have added notes to the corresponding clip. If notes have been added to a clip, the 
"Has Notes" column check box will be checked. If there are no notes associated with the clip, the check box will be 
blank. 

Has Tags – Denotes whether you have added tags to the corresponding clip. If tags have been added to a clip, the "Has 
tags" column check box will be checked. If there are no tags associated with the clip, the check box will be blank. 

Export- Checkbox indicates the clip has been marked for export. 

Clip List grid rows will be visible depending on the filter options set, either from the clip list filter options or the scan 
options filter available prior to scanning. Grid rows can be selected various ways: 

• LEFT CLICK on the desired row to select an individual row. Once focus is in the grid, move selection from row to 
row using the up and down keys on your keyboard. 
 

• To select multiple rows, LEFT CLICK the first row desired then SHIFT + LEFT CLICK the desired last row, hold 
SHIFT + UP/DOWN ARROW on your keyboard, or hold LEFT CLICK and drag the cursor across the rows you 
wish to select. 
 

• To select non-sequential rows, CTRL(CMD) + LEFT CLICK on the desired rows. 
 

• To mark multiple rows for export, select the desired rows using any of the methods mentioned above and click 
the "Mark Selected For Export" ribbon button.  Similarly, to un-mark multiple rows for export, select the desired 
rows using any of the methods mentioned above and click the "Unmark Selected For Export" ribbon button. 



 
Side Bar (Clip List Tab) 
 

 

Thumbnail – Clip thumbnails are only available for filesystems that support 
preview. A thumbnail image will be displayed if video properties have been 
collected for a clip. Video properties will be collected if a clip is Previewed, 
Processed for Motions, or selected for Get Video Properties. The thumbnail 
displayed will be the first reference frame of the clip selected. If thumbnails 
are supported for the filesystem, but a thumbnail has not been collected for 
the currently selected clip, the icon of a magnifying glass will display where 
the thumbnail would be (fig. 1). If multiple clips are selected the icon of 
multiple photos will display (fig. 2). If thumbnails are not supported for the 
current filesystem a gray circle icon will appear (fig. 3). 

 

       
Fig. 1                 Fig. 2                Fig. 3 

 
Notes and Tags- The Notes and Tags group box will be collapsed by default. 
This group box is only visible if one or more clips are selected.  Click the down 
arrow to expand the group box. Any notes added will be saved to that clip 
automatically. When multiple clips are selected, clip notes and tags for each 
clip will display in a grid format. Clip Notes and Tags may only be added to 
one clip at a time. 
 
 
 
 
 

Date/Time Offset- The Date/Time Offset group box will be collapsed by default. Click the down arrow to expand the 
group box. The Date/Time Offset in the side bar is used to adjust the date and time of specific clips.  Enter the amount 
of time the DVR is off from the actual time. If the time on the DVR is 1 hour behind the Actual time, enter "1" into the 
Hour(s) textbox and select the radio button for "Behind." If multiple clips are selected, any Offset adjustments will be 
applied to all selected clips.   

Note: to change the date/time of all clips, see Date/Time Configuration in Filter Options section.   

Update Filter To This Channel – This button will allow you to filter the clip list grid to only view the clips from the same 
channel as the clip you have selected when pressing the "Update Filter To This Channel" button. Pressing the "Clear" 
button in the main filter box will allow you to return to the full clip list.  

Update Filter To This Time Range – Pressing the "Update Filter To This Time Range" button will filter the clip list grid to 
only view the clips from the same time range as the clip you have selected. Pressing the "Clear" button in the main filter 
box will return the full clip list.  
Get Video Properties – Retrieves the thumbnail and resolution information for the selected clip or clips and update the 
side bar panel with the retrieved data. For clips that already have video properties, this button will be inactive.  

Mark/Unmark for Export – The Mark and Unmark for export buttons are additional ways to add a clip to export or 
remove a clip from export. These buttons will automatically update the export checkbox in the clip list grid.  
 
Export Selected Clip(s) – This button will immediately start an export job for the clip or clips currently selected. 

Audit Log – Collapsed by default, the Audit Log group box displays a grid view of activity associated with the currently 
selected clip or clips.  Audited activity for each clip include Export, Preview, Get Motion, and Get Metadata. 



 

Previewing a Clip 
 
When a clip is selected for preview, the clip will be loaded into a new tab.  The tab will be named “Preview – Clip #”.  
When a clip preview tab is active, the ‘View’ tab on the top ribbon changes to a ‘Preview’ tab.  The options on this tab 
are specific to the clip being previewed.  There are several ways to preview a clip: 

• Highlight a clip and select the ‘Preview Selected Clips’ icon from the Ribbon. 
• Highlight a clip, right click and select Preview Selected Clips. 
• Double click on a clip on the clip list grid.  

Note: Highlighting multiple clips and then selecting to preview the clips may slow down DVR Examiner.  It is 
recommended to select only a few clips at a time to preview (you can have multiple preview windows open at a time).   
 

 

Ribbon Buttons – Preview Tab 
 

 

Current Frame – Click to export a still of the current frame to the Desktop. Press SHIFT and the icon 
to select a save location. 
 

 

Entire Clip – Click to export the entire clip to the Desktop. Press SHIFT and the icon to select a save 
location. 
 

 

Update Motion Config. – Opens Motion Configuration Properties window. Adjust the motion 
sensitivity, minimum still time, and object size on a per channel basis. 

 

Send to iNPUT-ACE – Sends current clips to iNPUT-ACE.  iNPUT-ACE must be installed on your 
computer and open for this icon to be active.  
 

 

Send to VideoFOCUS – Sends current clips to VideoFOCUS.  VideoFOCUS must be installed on your 
computer and open for this icon to be active.  
 

 

Send to Amped FIVE – Sends current clips to Amped FIVE.  Amped FIVE must be installed on your 
computer and open for this icon to be active.  
 



 

 

Send to Axon Five – Sends current clips to Axon Five.  Amped FIVE must be installed on your 
computer and open for this icon to be active.  
 

 

Options – Opens a new tab for available user options.  See Options Tab section for more information.  
 

 

Exit Application - Closes DVR Examiner and cancels any Jobs in progress. 
 

 

Exit Current Tab- Closes the tab you are currently viewing. If an export is currently in progress the 
export will be canceled. 
 

 
 
 

Player Controls  
Player controls are located below the preview clip and help you navigate through a clip. 

 

 

Play/Pause – Stop and start video playback. 

 

Next/Previous Frame – Move forward or backward a single frame at a time. 

 

Jump Forward/Jump Back – Move forward or backward 25 frames at a time. 

 

First/Last Frame – Skip to the first or last frame of the clip. 

 

Speed Controls – Control the speed of the video. The fastest speed will be 4 
times the normal play rate and the slowest speed will be half the normal 
play rate. 
 

 

Video Progress Bar – Shows the clip’s progress as well as allow you to 
search the clip at your desired rate by moving the slider backwards or 
forwards. 
 



 

 

Current Frame Information – Displays current frame information, including 
timestamp, frame number, displayed and native resolution, as well as the 
type of frame it is, i.e. Reference Frame, Non-Reference Frame, I-Frame, P-
Frame, etc. 
 
 

 

Bad Frame Indicator - When you play a clip from the preview tab, DVR 
Examiner will now display an icon when it encounters a bad frame. 
Along with an indicator of a bad frame, the screen will be pure green. 
This represents a frame that was recorded incorrectly by the DVR or 
possible data corruption on the hard drive.. 
 

Side Bar (Preview Tab) 
Clip Information – This section provides clip specific information, including Earliest and 
Latest Date/Time, Size, and Resolution(s). 

Note: DVR Examiner will analyze every frame in the clip. If a clip contains frames with 
different aspect ratios, all the ratios will now be displayed. Native resolutions will update 
as the clip plays. A quick way to display all the resolutions within a clip is to play the clip 
at the ">>>" speed setting. 

Preview Notes – Add notes to individual clips.  The Notes field automatically saves any 
text entered or altered.  Notes added from the Clip List screen will be visible here.  

Clip Tags – Add tags to individual clips by entering tag name and pressing ‘Add’ or by 
selecting from the dropdown list.  

Add To Export – Adds the current clip to the export list without having to switch back to 
the clip list screen. 

Adjust Aspect Ratio – When the Aspect Ratio button is checked, each frame's aspect 
ratio is analyzed and may be adjusted for a better viewing experience. To learn more 

about how aspect ratio is adjusted for viewing, click here. 

Split Frame - In some instances, due to the encoding process of the DVR, DVR Examiner displays frames that are split. 
When a frame is displayed in two different fields, use this button to 'merge' the two fields into one. The Split Frame 
button will toggle between 3 settings: Off, Top Field First, or Bottom Field First.  

Overlay – This option will turn the timestamp overlay on and off in the upper left corner of the player window. On all 
metadata supported filesystems this option will be available regardless of burned in metadata created by the player. If 
an offset is applied, the overlay will display the user entered offset as well as the original timestamp. If you are currently 
using a trial license the Overlay option will only be available for the first clip of each channel. For all other clips the DVR 
Examiner Trial overlay will display and cannot be removed. 

Overlay Position and Color – The Overlay Position can be controlled by the "Four Corners" button. The Overlay will cycle 
from each corner of the player window starting in the upper left corner and progressing clockwise around the screen. 
Overlay Text Color can be changed to make the timestamp overlay easier to see depending on the color of the video. 
The three color options will apply to the entirety of the overlay text and selecting a new color will automatically deselect 
the current color. 

  

Gallery View 
New in 2.7.0 is the ability to view a clip in gallery view. For filesystems that support preview, when you 
highlight a clip and select Gallery View from the ribbon buttons, the clip will open in a separate gallery view 
tab. The gallery view tab, by default, will display a thumbnail for each iframe present in the clip. 

https://dmeforensics.com/2018/11/02/dvr-examiner-and-aspect-ratio/


 

 

You can change the number of frames displayed by changing the interval between each frame. 
Filesystems that support frame level timestamps will allow you to change the amount of time 
between frames (5, 30, 60 seconds, or 5 minutes). 

 

Filesystems that do not support frame level timestamps will allow you to change the number of 
frames (50, 300, 600, or 1200). 

 

Double click on any frame within the gallery view to open a preview tab for that clip queued up at 
the selected frame. 

 
 
 

  



 

Exporting a Clip 
 
When a clip export tab is active, the ‘View’ tab on the top ribbon changes to an ‘Export’ tab.   

 

 

There are several ways to export a clip: 

• Highlight a clip or multiple clips and select the ‘Export Selected Clips’ icon from View Tab in the Ribbon.  
 

• Highlight a clip or multiple clips, right click and select ‘Export Selected Clips’. 
 

• Highlight a clip or multiple clips, right click and select ‘Mark Selected Clips for Export’, then select ‘Export 
Marked Clips from the View Tab in the Ribbon.  
 

• If exporting all clips, simply select ‘Export All Clips’ from the View Tab in the Ribbon or press ‘CTRL+A’. 

Ribbon Buttons – Export Tab 
 

 
 

 

Options – Opens a new tab for available user options.  See Options Tab section for more information.  
 



 

 

Exit Application - Closes DVR Examiner and cancels any Jobs in progress. 
 

 

Exit Current Tab – Closes the tab you are currently viewing. If an export is currently in progress the 
export will be canceled. 
 

 
Side Bar (Export Tab) 
 

 

Destination (Required) – Select "Browse" to change the 
export destination. You will not be able to start the 
export until a destination is selected.  To set a default 
export location, see OPTIONS Tab section.  
 
Filesystem Export Details - Lists any requirements 
needed to play the native video files. 
 
Formats (Required) – Lists all available export format 
based on the DVR metadata. You will not be able to start 
the export until at least one export format is selected. 
 

• Native Video Files – When possible, DVR 
Examiner can export clips in the DVRs native file 
format.   
 

• Open Video Files – When possible, DVR 
Examiner can export clips in a .avi Open Format 
File playable in Windows Media Player or other 
external players. 
 

• Subtitles for AVI – Export .SRT files that will play 
time information over exported .avi files. See 
below for more information on .SRT files.  

 
Send to iNPUT-ACE – Sends current clips to iNPUT-ACE.  
iNPUT-ACE must be installed on your computer and 
open for options to be active.  
 
Download Native Player – If selected, DVR Examiner will 
automatically download the native player needed to play 
the native file formats. The player will be downloaded in 
the same folder as the exported clips and export report.    
 
Use Adjusted Date/Time in File Name – If selected, this 
option will label all clips with the adjusted date/time as 
opposed to the date/time recovered from the hard drive. 
If export folders are organized according to dates, the 
adjusted date will be used for folder organization as 
well.  
 
Hash Algorithm – Selecting a hash algorithm on 
exported clips assigns a hash value to each exported 
clip.  Select from None, MD5, SHA1, or MD5 & SHA1.  
Selecting any of the hash algorithms will lengthen the 
total export time. 



 
Folder Organization – The Folder Organization drop down determines how the exported clips will be organized within 
the destination folder.  

• Date/Files – puts all exported clips into separate folders depending on the date of the clip with a folder per day. 
 

• Channel/Files – puts all exported clips into separate folders depending on the channel of the clip with a folder 
per channel. 
 

• Date/Channel/Files – puts all exported clips into separate folders first separated by date then by channel with 
a folder per date then a folder per channel within each date folder. 
 

• Channel/Date/Files – puts all exported clips into separate folders first separated by channel then by date with 
a folder per channel then a folder per date within each channel folder. 

Include Notes/Tags – Selecting this option will include clip specific notes and tags in the Export Report.   
 
Report Format – The Report Format drop down will allow you to specify the output format of the export report. The 
export report is defaulted to PDF with the option to select Excel.  

Export Notes - Export Notes will automatically be included in the export report. 
 
Start Export- The Start Export button will only be enabled if you have selected a destination folder and at least one 
export video format. 
 

SRT Files - An SRT file, also known as a SubRip Subtitle file, is a text file that contains subtitle information for a video 
clip including the subtitle identifier, the subtitle start and end times for which the subtitle is to be displayed, and the 
subtitle text.  
 

 
 
Only filesystems with time information stored with each frame will support SRT files and is identified by an SRT Logo 
under the Output Formats on the Supported Features screen. 
 

 
 
Exporting SRT Files - If SRT files are supported, you have the ability to save them alongside the video clips you export.  
From the Export tab, select "Subtitles for AVI" from the Export format options.  
 



 

 
 
When the export is complete, open the export directory to a folder that contains exported clips.  Along with the actual 
exported clip, you will see a .SRT file with the exact same name as the corresponding .avi file.  
 

 
 
Players such as Windows Media Player and VLC Media Player automatically detect the SRT File and play it as a layer 
over the .avi file.   
 
Note:  Depending on other codecs you have installed, certain players may not display SRT files correctly, or at all.  
 

  



 

Options 
 
The Options tab contains user and application options as well as the job manager and associated actions. These 
options will be specific to the work station DVR Examiner is running on and will not carry over if the dongle is used on a 
different work station running an instance of DVR Examiner. Options are accessible by selecting the Options icon in 
the Clip List View tab or the preview tab when viewing a preview.   
 

 
 
User Options 

 
Select Date/Time Format – Choose between four different 
date/time formats. The selected date/time format will 
display throughout the entire application as well as on any 
generated reports. 

Always Scan for Mounted Images – By selecting this 
option, DVR Examiner will automatically check for any 
mounted images when ‘Detect and Scan Hard Drive’ 
option is selected from the landing screen. 
 

Default Export Destination – Specifies how DVR Examiner prompts for export destinations for any media being 
exported, you can always alter these options at the time of export. There are three export destination options: 

• Prompt – Each time an export is started, you will be prompted to enter a destination location for the 
exports. 
 

• Desktop – DVR Examiner will save any exported media to the desktop of the computer running the current 
instance of DVR Examiner. 
 

• Custom Directory – Designate a file path for all exported material.  Each time an export is started, the 
custom path will be displayed. 

Case Information Options – Specifies the visible fields and their default values to be displayed on the Case Information 
screen displayed while the source data is being scanned. 

• Show – Controls which fields are visible on the Case Information screen 
 

• Include in Reports – Controls which fields to display on any report generated by DVR Examiner. 
 

• Field Name – The Field Name column displays the label of the corresponding text box.  These fields are 
displayed on the Case Information screen. Change field names by double clicking on a Field Name.  
 



 
• Default Value – The Default Value field will display the default value specified for the related Field Name for 

every data source scanned. The Default Value can be changed on a case by case basis from the Case 
Notes screen that displays while the data source is being scanned. 
 

• Default and Case Tags – Any tags in the Default Tags 
grid list will automatically populate the Case Tags grid 
list when a new HDD is scanned.  The Case Tags grid 
list is automatically updated when a tag is entered in 
the Clip List or Preview Tab.  Removing a tag from the 
Case Tags grid list will remove that tag from all clips in 
which it was present.   

 
• Report Logo – This option allows you to select a logo 

that will appear on any report generate by DVR 
Examiner.  A .PNG file type is necessary, and we 
recommend a size of 5.03 x 0.7 inches.    

 

Global Options 
Global Options are applied to any instance of DVR Examiner on any work station when the current dongle or case 
license is used. 

 

 Participate in User Experience Program – A program aimed in helping DME 
Forensics gather usage data regarding DVR Examiner.  No personal data is 
ever collected, and all information sent is completely anonymous. 
 
Check for Application Updates at Start Up – DVR Examiner will automatically 
search for any software updates.  A web-connected computer is required for 
this functionality.  
 
Auto Update License Database – DVR Examiner will automatically search for 
any license database updates.  A web-connected computer is required for 
this functionality. 
 
 

Use Network Dongle – Agencies that use a Network dongle can select this option to have DVR Examiner automatically 
use the Network dongle to activate the software. 

Enable Debug Logging – Log files that help us troubleshoot issues and provide information pertaining to the DVR.  No 
personal data is ever collected, and all information sent is completely anonymous. 

 
Job Manager 
Job Manager allows you to view details on Pending, 
Running, and Completed jobs. You can pause currently 
running jobs, resume paused jobs, and cancel pending or 
running jobs.  
 
Job Details – Job Details will provide specific information 
about the job currently selected in the Jobs grid. 

Jobs – The Jobs grid will display all active, completed, and 
canceled jobs. If the Options tab is open when jobs are 
created, you will need to press the Refresh button for the 
newly created jobs to display in the grid. 



 
Job ID – A Job ID is assigned according to the order in which the job was created. If the options to display both Active 
and Ended jobs are selected, the grid will display Active Jobs above Ended jobs regardless of Job ID. 

Job Type – Displays the category of the job. Examples include: ‘Export’, ‘Preview’, or ‘Scan’. 

Job Status – The Status column will show the progress for Active, completed, or canceled jobs. 
Possible job statuses include: 

• Running 
• Paused 
• Pending 
• Completed 
• Completed with Errors 
• Failed 
• Canceled 

Progress – Displays the current progress of an active job as a percentage. ‘0’ means no progress has been made and 
‘100’ means the job is completed. 

Requested Time – Displays the date and time when the job was requested. 

Start Time – Displays the time the job began. 

End Time – Displays the time the job completed.  
 
Duration – Displays the time a job took to complete. Duration start when the job is in Progress and stops when the job 
is Completed. Duration is measured in minutes. 

Pause Job – Pauses a job that is currently running. 

Resume Job – Resumes a job that was previously paused.  

Cancel Job – Cancels any selected Active or Pending job. If a currently running job is cancelled, the next Pending job in 
the queue will automatically start. If a Pending job is cancelled, the job will be skipped at the point it would have been 
activated and the next pending job will be activated. 

Show Active – Displays or hides all Active and Pending jobs. 

Show Ended – Displays or hides all jobs that are not Active or Pending. 

Refresh – Updates the Jobs grid to reflect the most recent state of all jobs. 

 

 

DVR Examiner Updater 
 
DVR Examiner Updater allows you to continuously update your existing version of DVR Examiner with newly supported 
filesystems and improvements to existing filesystems.  
 



 

 

 
There are several ways to run DVR Examiner Updater: 
 

• Click the link on the notification screen within 
DVR Examiner (must be web connected). 
 

• Use the Windows start menu 
 

• Launch the DVRExaminer_Updater.exe from 
the DVR Examiner installation folder typically 
located at C:\Program Files\DVR Examiner. 

 
The process for updating the filesystem database version depends on whether or not your work station is internet 
connected.    

Internet Connection 
When you start DVR Examiner, and if a Filesystem Database Update (FDU) is available, a message will display stating 
that a new Filesystem Version is available. Clicking ‘Download Now’ will download the newest FDU into your FDUs 
folder and will prompt you to open the Updater and install the new FDU.    

 

1. Within DVR Examiner Updater, select the ‘Check Online for FDUs’ checkbox and then click on the ‘Check for 
Latest FDUs’ icon.  

2. A list of available FDUs will populate the grid. 
3. Click the ‘Download’ button next to the FDU you wish to install. 
4. Once the download is complete, the button will switch to an ‘Install’ button.  
5. Click ‘Install’ to install the FDU. 
6. The Button next to the FDU will now display ‘Installed’. 

No Internet Connection 
If your computer is not internet connected, you can download the latest FDU from our Support Portal and move the 
FDU to your work station.  

1. Visit portal.dmeforensics.com/portal to view available FDUs to download.   
2. Download a FDU and move the file to your workstation.   
3. In DVR Examiner Updater, click ‘+Add FDU’ to add the FDU File to the grid list.  
4. Click ‘Install’ to install the FDU. 
5. The Button next to the FDU will now display ‘Installed’ 

Note: If a FDU does not appear in the Updater grid after adding the FDU, refresh the Updater Grid by clicking the Check 
for Latest FDUs ribbon button.  



 
Updater Ribbon 
The Updater Ribbon provides options for adding new FDUs and managing Updater preferences.  
 

 

Add FDU – The Add FDU option allows you to move an FDU package into the Updater making it available for 
installation. 

Check for Latest FDUs – Refreshes the Updater grid to show any new FDUs that have been added and, if the "Check 
online for FDUs" checkbox is selected, add any new FDUs available on the user portal. 

DVR Examiner Directory – Select the location where DVR Examiner was installed.  This is initially set to the default 
location (C:\Program Files\DVR Examiner).  This path must be correct for the Updater to function correctly.   

FDU Directory – Select the location where DVR Examiner installs all FDU files.  This is initially set to the default location 
(C:\Program Files\DVR Examiner\FDUs). 

DVR Examiner Version – Displays the currently installed version of DVR Examiner as detected by the Updater. 

Check Online for FDUs – Select this checkbox to check Online for FDUs.  Your computer must be internet connected 
for this option to work.  If you are not working on an Internet connected machine, deselect this option for improved 
performance.  

Run DVR Examiner – Launch DVR Examiner directly from the Updater.  
 

Updater Grid 
The Updater Grid will show information about all available FDUs and their current state (installed, available to install, or 
available to download).  

FDU Installed - The currently installed FDU will show 
in the grid with the installation button disabled and 
the button text saying "Installed". 

FDU Available to Install- When an FDU is available to 
install the installation button in the grid will be 
enabled and the button text will say Install. An FDU is 
available to install when it is located in the FDUs root 
directory (having been downloaded with the updater 
or added manually via the ribbon option to Add FDU) 
and meets the minimum UI requirements. 

FDU Available to Download - These FDUs will only display if your work station is internet connected. An FDU is 
available to download if the FDU exists in the portal and not in the FDUs root directory. 

FDU Cannot be Installed - If an FDU does not match the minimum UI requirements, meaning that the installed version 
of DVR Examiner is not current enough to support that FDU, you will see a red exclamation next to the UI version. If you 
hover over this icon a tooltip will appear explaining that the UI does not match the FDU. You will still be able to 
download these FDUs - if web connected - so you can install them at a later date, but you will not be able to install the 
FDU until updating DVR Examiner. 
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